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    True/False Questions 
 Each of the following statements is either true or false. Indicate your 
choice by circling T or F.  

    1. You can adjust the width of individual columns in a table, but row 
heights must all be the same.  

    2. Effects can be used to give the table a dimensional look.  

    3. You don’t need to be exact when you define the size of a table because 
it’s easy to insert rows and columns later.  

    4. Borders are available in only one width.  

    5. Text in a table cell can have its vertical position adjusted independently 
of other cells.  

    6. When you insert a new column, it is always inserted to the left of the 
currently selected column.  

    7. Cell margins provide a space between cell borders and the contents of 
the cell.  

    8. After setting ruler tabs, you can remove one of these tabs by dragging it 
off the ruler.     

 Short Answer Questions 
 Write the correct answer in the space provided.  

  1.   What do you call the intersection between a column and a row? 

  2.   Other than dragging down all the cells or using a button on the Ribbon, 
how can you select a column in a table? 

  3.   What tab contains the Center Vertically button? 

  4.   What method can be used to select the entire table? 

  5.   What three types of 3-D effects are available to apply to a table? 

   Concepts Review 
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PP-193LESSON 5 Creating Tables

 Exercise 5-24 
 Create a table, key text, and apply table styles.  

   1.   Open the file  CookOff , and move to slide 4, “The Winning Fare.”  

   2.   Insert a new table by following these steps:

   a.   Click the Table button    in the content placeholder.  

  b.   In the dialog box that appears, choose two columns by four rows.     

   3.   Key text in the table by following these steps:

   a.   Click the upper left cell to select it, and then key  Name .  

  b.   Press Tab  to move to the next cell, and then key  Recipe Description .     

   4.   Key the text shown in  Figure 5-24  for the remaining cells. 

   Skills Review 
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  6.   What are the three methods of merging cells in a table? 

  7.   What is different about splitting a cell diagonally compared to splitting 
it horizontally or vertically? 

  8.   What’s the quickest way to make a group of selected columns of varying 
widths all the same width? 

 Critical Thinking 
 Answer these questions on a separate page. Support your answers with 
examples from your own experience, if possible.  

  1.   Why might you choose to put information in a table instead of in a 
bulleted placeholder?  

  2.   Tables can be created in three ways: inserting, drawing, or tabbing. Why 
would you choose one method over another? What criteria would affect 
which method you use?      
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  Figure 5-24
  Table text    

        5.   Apply a table style from the Best Match for Document category by 
following these steps:

   a.    Select the table by right-clicking within the table and choosing Select 
Table from the shortcut menu.  

  b.    From the Table Tools Design tab, in the Table Styles group, click the 
More button   .  

  c.    From the  Best Match for Document  category, choose Themed Style 1, 
Accent 1.     

   6.   Create a slide footer for the current slide (slide 4 only) containing 
today’s date, your name, and  [your initials]  5-24 .  

   7.   Move to slide 1, and save the presentation as  [your initials]  5-24  in your 
Lesson 5 folder.  

   8.   View the presentation as a slide show from slide 1.  

   9.   If your instructor requires a printout, print slide 4 only. If you have a 
color printer, print it in color.     

 10. Close the presentation and submit your work.

 Exercise 5-25 
    Draw a table, and apply border and shading options.  

   1.   Open the file  Operations1 .  

   2.   Insert a new slide after slide 3 that uses the Title Only layout. Key the 
title Capital Equipment 2012.  

   3.   Draw a new table by following these steps: 

  a.    From the Insert tab, in the Tables group, click the Table button   , 
and choose Draw Table.  

  b.    Use the pencil pointer to draw a table from under “Capital” to under 
“2012” and down about 3.5 inches on the ruler.  

  c.    From the Table Tools Design tab, in the Draw Borders group, click the 
Draw Table button   .  
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PP-195LESSON 5 Creating Tables

  d.   Click and drag two vertical borders to create three columns.  

  e.   Click and drag four horizontal borders to create five rows.  

  f.   Press Esc  to turn off the pencil pointer.     

   4.   For the table text, key the information shown in  Figure 5-25 .      

  Figure 5-25
  Table text in 

completed table    

       5.   Apply shading effects to table cells by following these steps: 

  a.    Move the pointer to the outside of the table beside row 1; when you 
get a right-facing arrow, click to select all the cells in the first row.  

  b.    From the Table Tools Design tab, in the Table Styles group, click the 
Shading button   .  

  c.   Choose Aqua, Text 2, Lighter 40%.  

  d.    Click the list box arrow on the Shading button again, and choose 
Gradient.  

  e.   In the Variations category, choose From Center.  

  f.    With the first row still selected, change the font color to a deep blue: 
Indigo, Accent 6, Darker 50%. Apply bold to the first row.  

  g.   Horizontally center the first row of text.     

   6.   Make all the columns the same width and all the rows the same height 
by following these steps: 

  a.    Select the entire table by right-clicking within the table and choosing 
Select Table.  

  b.    From the Table Tools Layout tab, in the Cell Size group, click the 
Distribute Columns button   .  

  c.    From the Table Tools Layout tab, in the Cell Size group, click the 
Distribute Rows button   .  

  d.    With the table still selected, change the font size of the entire table to 
24 points.     

   7.   Remove all the table’s borders by following these steps: 

  a.   Select the entire table.  

  b.    From the Table Tools Design tab, in the Table Styles group, click the 
Borders button   , and choose No Border.     
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   8.   Select all cells with numbers and the column heading cells; then make 
them right-aligned.  

   9.   Create a handout header and footer: Include the date, your name as the 
header, the page number, and  [your initials]  5-25  as the footer.  

  10.   View the presentation as a slide show.  

  11.   Move to slide 1, and save the presentation as  [your initials]  5-25  in your 
Lesson 5 folder.  

  12.   Close the presentation and submit your work.     

 Exercise 5-26 
 Draw a table, insert and delete rows and columns, adjust column and row 
width, and apply formatting for text, shading, and borders.  

   1.   Open the file  Operations2 .  

   2.   Display slide 5, titled “Reservation Requests.”  

   3.   Draw a table on slide 5 by following these steps: 

  a.    From the Insert tab, in the Tables group, click the Table button   , 
and choose Draw Table.  

  b.    Use the pencil pointer to draw a table from under the “v” in “Average” 
to the right edge of the slide and down about 3.5 inches on the ruler.  

  c.    From the Table Tools Design tab, in the Draw Borders group, click the 
Pen Color button   , and choose Light Blue, Accent 6, Darker 50%.  

  d.    Within the table, draw four vertical lines (to create five columns) and 
three horizontal lines (to create four rows). They don’t need to be the 
same size.  

  e.   Press Esc  to turn off the pencil pointer.     

   4.   For the table’s text, key the data in  Figure 5-26 . Adjust the size of the 
table as needed to match the figure. 

  Figure 5-26
  Table text    
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PP-197LESSON 5 Creating Tables

        5.   Select the table, and make the text bold. Make all the numbers Light 
Blue, Accent 6, Darker 50%.  

   6.   Insert a new row between “Weekends” and “Memorial Day” by following 
these steps: 

  a.   Right-click “Memorial Day.”  

  b.   Choose Insert from the shortcut menu, and choose Insert Row Above.     

   7.   Insert a new column to the left of “Brunch” by following these steps: 

  a.   Click anywhere in the “Brunch” column.  

  b.    Click the Table Tools Layout  tab, in the Rows & Columns group, and 
c hoose Insert Left.     

   8.   Delete a column and a row by following these steps: 

  a.   Select the entire “Late Night” column.  

  b.    Right-click the selection, and choose Delete Columns from the 
shortcut menu.  

  c.    Select the “Memorial Day” row. Right-click the selection, and choose 
Delete Rows from the shortcut menu.     

   9.   In the second column, key  Breakfast  for the column heading. Key  5  for 
“Weekday” and  18  for “Weekends.” Change the “Weekday” cell to 
 Weekdays .  

  10.   Key the following information in the new row:  

      Holidays,  Tab   6,  Tab   9,  Tab   15,  Tab   94   

  11.   Move the table to a new position, and change its size by following these 
steps: 

  a.    Right-click anywhere inside the table, and choose Select Table from 
the shortcut menu.  

  b.    Move your pointer over the table’s border until you see the four-
pointed arrow   . If necessary, drag the table to position it on the 
white area of the slide so that all the numbers are easy to read.  

  c.    Make the table wider by dragging the right-center sizing handle to 
the right until all text and numbers are on one line. Before you drag, 
make sure the pointer appears as   .     

  12.   Make all the columns the same width and all the rows the same height. 
Then adjust the first column size as needed to fit all the text on one line.  

  13.   Align the text horizontally by following these steps: 

  a.    Select the first row by clicking the first cell and dragging down to the 
last cell.  

  b.    From the Home tab, in the Paragraph group, click the Center 
button    (or press Ctrl + E ).  

  c.    Select all the cells that contain numbers by dragging diagonally 
across the cells.  

  d.    Click the Align Text Right button    (or press Ctrl + R ) to right-align 
the numbers.     

  14.   Change the cell margin settings by following these steps: 

  a.   Make sure all the cells that contain numbers are selected.  
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  b.    From the Table Tools Layout tab, in the Alignment group, choose the 
Cell Margins button   , and choose Custom Margins.  

  c.    In the Internal margin section, key  0.5”  in the Right text box. Click 
OK.     

  15.   Change the vertical alignment of text and numbers in their cells by 
following these steps: 

  a.    Select the entire table from the Table Tools Layout tab, in the Table 
group, by clicking the Select button    and Select Table.  

  b.    Still working on the Table Tools Layout tab, in the Alignment group, 
click the Center Vertically button   .     

  16.   Create a handout header and footer: Include the date, your name as the 
header, the page number, and  [your initials]  5-26  as the footer.  

  17.   Move to slide 1, and save the presentation as  [your initials]  5-26  in your 
Lesson 5 folder.  

  18.   View the presentation as a slide show. Close the presentation and 
submit your work.     

 Exercise 5-27 
 Insert a table, merge cells, and work with tabbed tables.  

   1.   Open the file  Miami Beach .  

   2.   Insert a new slide after slide 2, and use the Title and Content layout. Key 
 Appetizers  as the title.  

   3.   Set a decimal tab at the 4.5-inch position on the ruler by following these 
steps: 

  a    Click in the body text placeholder.  

  b.   Click the Tab Alignment button    until the Decimal Tab    appears.  

  c.   Click the ruler at the 4.5-inch position.     

   4.   Key the following in the body text placeholder, pressing Tab  before each 
price:

Wild Rice Soup Tab  6.25

Dill Cucumber Salad Tab  5.50

Four Bean Salad Tab  5.25  

   5.   Insert a new slide after slide 3, and use the Title Only layout. Key  Entrée 
Selections  as the title.  

   6.   Insert a table with three columns and seven rows.  

   7.   Merge the cells in rows 3, 5, and 7 using the following 
steps: 

   a.   Select the cells in row 3.  

   b.    From the Table Tools Layout tab, in the Merge 
group, choose the Merge Cells button   .  

   c.   Repeat the process for row 5 and row 7.     

 TIP 

 You can use right tabs instead of decimal 
tabs to align numbers if all the numbers 

in the list have the same number of 
decimal places. 
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PP-199LESSON 5 Creating Tables

   8.   Key the text shown in  Figure 5-27  into your table. 

  Figure 5-27
  Completed table 

with table text    

        9.   Move the table down and to the right, and resize as necessary the table, 
columns, and rows.  

  10.   Center the text vertically in the table rows.  

  11.   Create a handout header and footer: Include the date, your name as the 
header, the page number, and  [your initials]  5-27  as the footer.  

  12.   Save the presentation as  [your initials]  5-27  in your Lesson 5 folder.  

  13.   Review the presentation as a slide show.  

  14.   Close the presentation and submit your work.    
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 Lesson Applications 

 Exercise 5-28 
 Create a presentation with a table slide, apply table styles, arrange and 
format text, and change column widths and table size.  

   1.   Open the file  Print .  

   2.   Insert three slides after slide 1. Use the Title and Content layout for all 
three slides.  

   3.   Key the text shown in  Figure 5-28 . 

            4.   On slide 4, select the Table button    from the content placeholder, 
and select the correct number of columns and rows before keying the 
information. Select the entire table, and change the font to Dark Red, 
Text 1. In the first row, press Enter  to divide the text in each cell into 
two lines of text as shown in Figure 5-28.  

Print Advertising 2011 

   •   Campaigns use a variety of print media  

   •   Each medium targets a specific market segment  

   •    Every campaign must meet specific sales objectives   

Coupon Redemption 

   •   Effective measure of return on investment  

   •    Used for promotional purposes in a variety of 

print media   

Coupons Redeemed 2010

Column 1 Column 2 Column 3 Column 4

Row 1 Newspaper and Coupons Average Cost of

 Magazine Redeemed Check One Ad

Row 2 NY Times 414 $31.50 $6,800

Row 3 NY Magazine 476 $25.00 $2,850

Row 4 NY Runner 1,063 $23.50 $975

Row 5 NY Health 125 $16.25 $650

Slide 2

Slide 3

Slide 4

 Figure 5-28
  Presentation content   

   5.   On slide 4, change the Table style to Themed Style 2, Accent 4 in the 
Best Match for Documents category.  

   6.   For the entire table, change all right and left cell margins to 0.2". Using 
the resize column arrow   , double-click each column border so that 
each column self-adjusts to fit the widest text in the column.  
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PP-201LESSON 5 Creating Tables

   7.   Center the headings for the columns containing numbers.  

   8.   Right-align all numbers.  

   9.   Vertically center all text and numbers in the table.  

  10.   Adjust the overall size and position of the table for attractive positioning 
on the slide, as shown in  Figure 5-29 . 

  Figure 5-29
  Completed table 

slide    

       11.   Create a slide footer for the current slide (slide 4) containing today’s 
date, your name, and  [your initials]  5-28 .  

  12.   Create a handout header and footer: Include the date, your name as the 
header, the page number, and  [your initials]  5-28  as the footer.  

  13.   Save the presentation as  [your initials]  5-28  in your Lesson 5 folder.  

  14.   View the presentation as a slide show.  

  15.   Close the presentation and submit your work.     

 Exercise 5-29 
 Insert a table slide; insert rows; change row height, column width, 
alignment, and cell margins; and apply a 3-D effect.  

   1.   Open the file  Ads .  

   2.   On slide 1, change “Student Name” to your name.  

   3.   Insert a table on a new slide after slide 1 using the Title and Content 
layout, and key the text shown in  Figure 5-30 . 
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        4.   Resize the title placeholder so that the text fits on one line.  

   5.   Apply the following formatting to the table’s text:

   •   Center the text in the first row.  

  •    Right-align all the numbers, and apply a 1-inch right cell margin so 
that the numbers appear centered under their headings.  

  •    Apply a 0.25-inch left cell margin to all the cells in the first column.  

  •    If necessary, adjust the column width of the first row so that “Yellow 
Pages” is on one line.     

   6.   Insert a row above “Yellow Pages” with the following text:

Mailers 12% 18%  

   7.   Make the table easy to read by adjusting the column widths, row 
heights, and vertical alignment of cells, as necessary. Resize and 
reposition the table appropriately on the slide.  

   8.   Change the table style to Themed style 1, Accent 1.  

   9.   Select all the text in the table except the first row, and change the font 
to Gray-50%, Background 2, Darker 50%.  

  10.   Add a Convex cell bevel to the entire table. Compare your slide with the 
table in  Figure 5-30 , and make any necessary changes.  

  11.   Create a slide footer for the current slide (slide 2) containing today’s 
date, your name, and  [your initials]  5-29 .  

  12.   Create a handout header and footer: Include the date, your name as the 
header, the page number, and  [your initials]  5-29  as the footer.  

  13.   Check spelling, and change any words that need to be corrected.  

  14.   Save the presentation as  [your initials]  5-29  in your Lesson 5 folder.  

  15.   View the presentation as a slide show.  

  16.   Close the presentation and submit your work.     

  Figure 5-30
  Table text    
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 Exercise 5-30 
 Create a tabbed table.  

   1.   Start a new blank presentation. Use the Concourse design theme with 
the Equity color theme.  

   2.   On slide 1, key a two-line title with the text  Good 4 U  and  Softball 
Schedule .  

   3.   Key  Spring/Summer 2012  for the subtitle.  

   4.   Find a softball clip art image, and insert it on the title slide in the color 
bar at the bottom. Duplicate the softball several times, and resize the 
images and arrange them so that they get progressively smaller. If an 
image is unavailable, use Softball.gif from the student files. See 
 Figure 5-31  for an example. 

  Figure 5-31
  Slide 1    

        5.   Using the Title Only layout, create slide 2 as shown in  Figure 5-32 . Key 
the table and its heading all in one text box, and format the table as 
follows: 

  •    Set appropriate tabs (approximately 2.5-inch center tab, 5-inch center 
tab, 8-inch right tab). 

   •   Add bold to the headings.  

  •   Change the font size of the table to 24 points.  

  •   Apply 1.5 spacing to the table.  

  •   Position the table appropriately on the slide.     

   6.   Add the same softball used in slide 1 to the bottom left corner of slide 2. 
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  7.   Using the Title and Content layout, create slide 3 as shown in  Figure 5-33 . 

    8.   Copy and paste the softball from slide 2 onto slide 3, and insert a softball 
image recolored to match the theme colors on the right of the slide. 

  Figure 5-32
  Slide 2    

  Figure 5-33
  Slide 3    

        9.   Check spelling in the presentation. The names of team members are 
spelled correctly; do not make any changes.  

  10.   Create a handout header and footer: Include the date, your name as the 
header, the page number, and  [your initials]  5-30  as the footer.  

  11.   Save the presentation as  [your initials]  5-30  in your Lesson 5 folder.  

  12.   Close the presentation and submit your work.     
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  Figure 5-34
  Table slide    

        4.   Use appropriate alignment techniques, fill colors, and border 
treatments. Use a preset gradient color for the heading row fill for a 
gold appearance. (This option is found under More Gradients.)  

   5.   Distribute the columns and rows evenly.  

   6.   Using the Title and Content layout, insert a new slide after slide 4 with 
the title  Estimated Budget 2011 . Use  Figure 5-35  as an example as you 
create the table. Choose an appropriate table style to coordinate with 
the theme. 

    7.   Adjust the size of the columns, rows, and table as necessary. Use wide 
cell margins.  

   8.   Select the table, and choose the Reflection effect Half Reflection, 4 pt offset. 
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 Exercise 5-31    Challenge Yourself 
 Edit and format a presentation including a table slide, add data, change 
alignment, change table colors, and merge cells.  

   1.   Open the file  MarketSummary .  

   2.   Create a table on a new slide after slide 3 using the layout Title Only. 
Key the title  Marketing Expenses 2010 .  

   3.   Draw a table using the pencil pointer; then use  Figure 5-34  as an 
example as you create the table. For the column heading font, use 24 
points, brown, and bold; for the remaining text, use 18 points, white, 
and bold. 
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 On Your Own 

    In these exercises you work on your own, as you would in a real-life work 
environment. Use the skills you’ve learned to accomplish the task—and be 
creative.  

 Exercise 5-32 
 Chef Michele will soon be giving a cooking class. She wants to use a slide 
show to display the finished dish, share the recipe, and feature the 
preparation steps as she demonstrates how to prepare the dish. Find a 
recipe that you can use for this purpose (one of your own or one you like 
from  http://allrecipes.com ). Create a title slide with the name of the food 
dish, where the recipe came from, and, if possible, a picture of the finished 
dish. Add one or two slides describing in general terms what the dish 
contains and why it is a healthy choice. Create a series of slides containing 
tables that present the ingredients and the steps in creating the dish. Design 
your own table structures to present the information in a way that you think 
is easy to understand; use inserted tables with table styles applied 
consistently throughout the presentation. Format your presentation 
attractively, picking up colors, fonts, and other style features that accent the 
recipe you have chosen. Save your presentation as  [your initials]  5-32 . 
Close the presentation and submit your work.   

        9.   Create a handout header and footer: Include the date, your name as the 
header, the page number, and  [your initials]  5-31 as the footer.  

  10.   Check spelling in the presentation.  

  11.   Save the presentation as  [your initials]  5-31  in your Lesson 5 folder.  

  12.   Close the presentation and submit your work.      

  Figure 5-35
  Table slide    
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 Exercise 5-33 
    Find a schedule of events from your local newspaper or other source, for 
example, a movie schedule, your class schedule, the TV listings, or a 
schedule of community or school events. Create a presentation containing a 
table that lists those events in a way you think is easy to understand. Create 
a second table listing the three events or classes you think are the most 
interesting in one column and a description of those events in a second 
column. The presentation should include a title slide, two table slides, and 
any other slides you think will enhance your presentation. Use your 
creativity to make the tables interesting and fun to view. Be sure to resize 
the table and cells as needed and add borders, shading, and effects to add 
interest. Save the presentation as  [your initials]5-33 . Close the presentation 
and submit your work.   

 Exercise 5-34 
    Assume that you are the manager of a movie rental business and you need 
to promote sales of previously viewed movie DVDs to reduce your inventory. 
Prepare a single-slide presentation that you can print as a flyer and display 
for customers to see when they visit the store. Create columns based on 
categories that would help describe the movie in a concise way, such as the 
movie title, lead actors, rating, and cost. Apply a table style to make this 
flyer attractive and eye-catching. Use WordArt to create a bold title. Save 
the presentation as  [your initials]  5-34 . Close the presentation and submit 
your work.                                                                                                                                                                                                          
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